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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 

“ZENA™ Wireless Network Analyzer User’s Guide”. Items discussed in this chapter 

include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Web Site

• Development Systems Customer Change Notification Service

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to use the ZENA Wireless Network Analyzer as a 

development tool to monitor and analyze wireless network traffic. The manual 

layout is as follows: 

• Chapter 1. ZENA™ Wireless Network Analyzer Overview – This chapter intro-

duces the ZENA Wireless Network Analyzer hardware and software, and briefly 

describes their capabilities. 

• Chapter 2. Getting Started – This chapter describes how to install the ZENA 

software. 

• Chapter 3. ZigBee™ Protocol Tools – This chapter describes how to use the 

ZigBee protocol tools provided with the ZENA analyzer. Both basic and advance 

monitoring techniques are shown.

• Chapter 4. MiWi™ Wireless Networking Protocol Tools – This chapter 

describes how to use the MiWi protocol tools provided with the ZENA analyzer. 

Both basic and advance monitoring techniques are shown. 

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 

documentation are constantly evolving to meet customer needs, so some actual dialogs 

and/or tool descriptions may differ from those in this document. Please refer to our web site 

(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 

page, in front of the page number. The numbering convention for the DS number is 

“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 

document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 

Select the Help menu, and then Topics to open a list of available on-line help files.
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• Chapter 5. MiWi™ P2P Wireless Networking Protocol Tools - This chapter 

describes how to use the MiWi P2P protocol tools provided with the ZENA 

analyzer.

CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 

dialog

“Save project before build”

Underlined, italic text with 

right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 

where N is the total number of 

digits, R is the radix and n is a 

digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 

any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 

character: { | }

Choice of mutually exclusive 

arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 

user

void main (void)
{ ...
}
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RECOMMENDED READING

This user’s guide describes how to use the ZENA Wireless Network Analyzer. Other 

useful documents are listed below. The following Microchip documents are available 

and recommended as supplemental reference resources.

Readme for ZENA Wireless Network Analyzer

For the latest information on using the ZENA Wireless Network Analyzer, read the 

Readme file in the ZENA software installation directory. The Readme file contains 

update information and known issues that may not be included in this user’s guide.

PIC® MCU Data Sheets and Family Reference Manuals

See the Microchip web site for complete and updated versions of device data sheets 

and related device family reference manuals.

Microchip 8-Bit PIC® Microcontroller Solutions (DS39630)

This document provides an overview of the features and functionality of the 8-bit PIC 

microcontroller product family. It highlights its powerful architecture, flexible memory 

technologies and easy-to-use development tools.

AN1232, Microchip ZigBee-2006 Residential Stack Protocol (DS01232)

This application note assists designers who are interested in adopting the ZigBee 

protocol in their applications.

AN965, Microchip Stack for the ZigBee™ Protocol (DS00965)

This application note describes how you can use the Microchip Stack for the ZigBee 

protocol to quickly build your application. To illustrate the usage of the Stack, working 

demo applications are included. 

ZigBee™ Protocol Specification

See the ZigBee protocol web site for the complete and most recent revisions of the 

ZigBee protocol (http://www.zigbee.org).

PICDEM™ Z Demonstration Kit User’s Guide (DS51524)

The PICDEM Z Demonstration Kit is designed to allow developers to evaluate and 

experiment with Microchip solutions for the ZigBee protocol. The PICDEM Z 

Demonstration Kit provides two ZigBee protocol nodes to create a simple, two-node 

network.

AN1066, MiWi™ Wireless Networking Protocol Stack (DS01066)

This application note describes how you can use the Microchip Stack for the MiWi 

protocol to quickly build your application. To illustrate the usage of the Stack, working 

demo applications are included. 

IEEE 802.15.4™ Specification

See the IEEE web site for the complete and most recent revisions of the IEEE 802.15.4 

specification (http://www.ieee.org).
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THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 

site is used as a means to make files and information easily available to customers. 

Accessible by using your favorite Internet browser, the web site contains the following 

information:

• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 

latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 

support requests, online discussion groups, Microchip consultant program 

member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 

press releases, listing of seminars and events, listings of Microchip sales offices, 

distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 

products. Subscribers will receive e-mail notification whenever there are changes, 

updates, revisions or errata related to a specified product family or development tool of 

interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 

Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers and other language 

tools. These include the MPLAB C18 and MPLAB C30 C compilers; MPASM™ 

and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 object linkers; 

and MPLIB™ and MPLAB LIB30 object librarians.

• Emulators – The latest information on Microchip in-circuit emulators.This 

includes the MPLAB ICE 2000 and MPLAB ICE 4000.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 

debugger, MPLAB ICD 2.

• MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 

Integrated Development Environment for development systems tools. This list is 

focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager 

and general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 

the MPLAB PM3 and PRO MATE II device programmers and the PICSTART® 

Plus and PICkit™ 1 development programmers.
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 

(FAE) for support. Local sales offices are also available to help customers. A listing of 

sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY

Revision A (April 2006)

• Initial Release of this Document.

Revision B (January 2007)

• Updated existing ZigBee protocol Stack information and added MiWi™ protocol 

chapter.

Revision C (September 2008)

• Updated APO and ZDO screenshots and information.

• Updated existing ZigBee protocol Stack information.

• Added Chapter 5. “MiWi™ P2P Wireless Networking Protocol Tools”.



ZENA™ Wireless Network Analyzer User’s Guide

DS51606C-page 6 © 2008 Microchip Technology Inc.

NOTES:



ZENA™ WIRELESS NETWORK

ANALYZER USER’S GUIDE

© 2008 Microchip Technology Inc. DS51606C-page 7

Chapter 1.  ZENA™ Wireless Network Analyzer Overview

1.1 INTRODUCTION

This chapter introduces the ZENA Wireless Network Analyzer hardware and software, 

and briefly describes their capabilities. The ZENA analyzer provides three main tools 

to develop IEEE 802.15.4 solutions quickly and efficiently with the free Microchip 

Stacks for the ZigBee™ protocol and the MiWi™ protocol. The ZENA analyzer enables 

developers to quickly modify and adapt the Stacks to suit application requirements. The 

ZENA analyzer is also an IEEE 802.15.4 packet analyzer, currently supporting the 

2.4 GHz spectrum. The ZENA analyzer is capable of decoding ZigBee protocol v1.0 

and MiWi protocol packets. The ZENA analyzer also provides network analysis 

support. The ZENA analyzer draws the network topology of the network as it is formed 

and allows users to watch packet transactions as they occur, record the packet trans-

actions and play these packets back at variable speeds. These tools, combined, form 

a powerful tool in wireless development for the IEEE 802.15.4 protocol.

1.2 ZENA™ WIRELESS NETWORK ANALYZER KIT CONTENTS

The ZENA Wireless Network Analyzer kit contains the following items:

• ZENA Wireless Network Analyzer

• USB mini-B cable

• ZENA Wireless Network Analyzer CD-ROM

1.3 ZENA™ ANALYZER OVERVIEW

The ZENA Wireless Network Analyzer board, seen in Figure 1-1, combines the 

PIC18LF2550 for full-speed, USB support with an IEEE 802.15.4 transceiver.

Note: The ZENA Wireless Network Analyzer board does not have to be attached 

to the computer to use the configuration tool or the playback functionality.
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FIGURE 1-1: ZENA™ WIRELESS NETWORK ANALYZER BOARD

The ZENA Wireless Network Analyzer uses a USB mini-B cable to connect to the PC. 

The ZENA analyzer is powered by the USB bus. A PCB trace antenna receives the 

packets on the specified channel and sends the information over USB to the PC 

computer using the HID standard class.
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Chapter 2.  Getting Started

2.1 INTRODUCTION

This chapter describes how to install the ZENA Wireless Network Analyzer software.

2.2 INSTALLING ZENA™ ANALYZER SOFTWARE

Since the ZENA analyzer software can be used independently of the hardware, it is 

available from multiple sources, including the ZENA Wireless Network Analyzer 

CD-ROM, the installation for source files of AN965, “Microchip Stack for the ZigBee™ 

Protocol”, and the installation for source files of AN1066, “MiWi™ Wireless Networking 

Protocol Stack”. The version shipped with the application notes is a demo version, 

which provides Stack configuration and packet playback capability, but does not allow 

real-time network monitoring with the ZENA Wireless Network Analyzer hardware. The 

full version is shipped with the ZENA Wireless Network Analyzer board.

If you are installing the software from the ZENA Wireless Network Analyzer CD-ROM, 

insert the CD-ROM into your computer’s CD-ROM drive. If the installation program 

does not start automatically, browse to the CD-ROM directory and execute the 

ZENAvn.nn.exe program, where n.nn is the version number of the ZENA analyzer 

software. Follow the on-screen directions to install the software.

If you have installed the source code for one of the Microchip supported IEEE 802.15.4 

protocols, the demo version of ZENA analyzer software is installed automatically in the 

root directory of the application source code. The demo version of the software allows 

access to the Stack configuration and message playback features, but it will not 

communicate with the ZENA Wireless Network Analyzer hardware.

The ZENA Wireless Network Analyzer license agreement is presented. Read the 

agreement, then click I Accept to continue.

The ZENA Wireless Network Analyzer Readme file contains important information 

about the most recent release of the ZENA Wireless Network Analyzer, such as new 

features and known issues. The Readme file will change with each release. 

Once the ZENA software is installed, use the Start Menu item to launch the software. 

The introductory screen appears as follows.

FIGURE 2-1: ZENA™ ANALYZER SOFTWARE MAIN WINDOW
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Chapter 3.  ZigBee™ Protocol Tools

3.1 INTRODUCTION

This chapter describes how to use the ZigBee™ protocol tools provided by the ZENA 

Wireless Network Analyzer. Both basic and advance monitoring techniques are 

demonstrated.

3.2 MICROCHIP STACK CONFIGURATION TOOL

Microchip provides a freely available Stack as part of application note, AN965, 

“Microchip Stack for the ZigBee™ Protocol”. The application note and source code are 

available for download from the Microchip web site (www.microchip.com). After you 

have reviewed the application note and studied the demonstration projects, you will be 

ready to start your own ZigBee protocol application.

The ZENA analyzer will greatly assist you with configuring the Microchip Stack by auto-

matically generating a portion of the source code for your ZigBee protocol application. 

Be sure to refer to AN965, “Microchip Stack for the ZigBee™ Protocol” for details about 

each ZigBee protocol configuration option. Select ZigBee™ Tools>Stack Configuration 

from the main ZENA™ Stack Configuration window. The ZENA™ Stack 

Configuration - ZigBee™ Protocol window will be displayed. Using the tabbed dialog, 

you can select all of the options required for your ZigBee protocol application. The 

ZENA software will automatically enable and disable certain options depending on the 

selections you have made.



ZENA™ Wireless Network Analyzer User’s Guide

DS51606C-page 12 © 2008 Microchip Technology Inc.

3.2.1 Specifying ZigBee Protocol Device Information

Select the ZigBee Device tab.

FIGURE 3-1: ZENA™ STACK CONFIGURATION WINDOW, 

ZIGBEE DEVICE TAB
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Using this window, you can configure the following items:

TABLE 3-1: ZigBee™ PROTOCOL DEVICE CONFIGURATION SELECTION

Configuration Option Description

MAC Address Each and every ZigBee protocol device must have its own unique MAC address. The 

Microchip OUI is provided as a default for development purposes only. Please see 

AN1232, “Microchip ZigBee-2006 Residential Stack Protocol” for additional 

information.

ZigBee Device Type ZigBee protocol defines three different types of devices. Select the device type of your 

application.

IEEE Device Type Some ZigBee protocol devices have the option of selecting the IEEE device type. 

Select the appropriate IEEE device type for your application.

ZDO/APS/NWK/MAC 

Defaults for Device Type

When you change the device type, the ZENA™ analyzer will automatically set many 

options to their default settings unless you have altered them. Click this button if you 

have altered them and would like to restore them to their default values.

Transceiver Power Offers transceiver power selection. Selects how the transceiver is powered.

Initial Power Source Offers power source selection. Selects your application’s power source.

Available Power Sources Selects the power sources that are available to your application.

Alternate PAN Coordinator This option is currently not supported by the Microchip Stack for ZigBee protocol.

Manufacturer Code (Hex) Each manufacturer of ZigBee protocol devices is assigned a manufacturer code by 

the ZigBee Alliance. Enter the four digit hex value.

RFD Internal Data Request 

Rate (seconds)

If your device is an RFD, it must explicitly request data to receive messages. Some 

messages sent internally by the Stack itself will generate a response from the recipient 

that must be received. Enter the internal poll rate for these messages. Note that this 

polling is independent from the message polling required by the application.
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3.2.2 Specifying Transceiver Information

Select the Transceiver tab.

FIGURE 3-2: ZENA™ STACK CONFIGURATION WINDOW, 

TRANSCEIVER TAB

Using this window, you can configure the following items:

TABLE 3-2: ZigBee™ PROTOCOL TRANSCEIVER CONFIGURATION SELECTION

Configuration Option Description

Transceiver Selects one of the transceivers supported by the Stack.

Frequency 

Band

This combo box shows the various available frequency bands of the selected transceiver. If the transceiver 

supports only one frequency band, that frequency will be displayed and the combo box will be disabled.

Output Power Selects the initial output power of the transceiver.

Pin 

Assignments(1)
This panel shows the required pins for the selected transceiver. The Stack allows you to change these pin 

connections to application-specific port pins.

PICDEM™ Z 

Pins

Click this button to restore the pin assignments to the connections used by the PICDEM Z Demonstration 

Board.

Allowed 

Channels

This area shows the channels that are supported by the selected frequency band. Selecting channels 

here will generate a label that can be used to specify the allowed channels for network formation and 

network discovery. Click Clear All to uncheck all channels and click Select All to check all channels. 

Each channel can also be checked or unchecked individually by clicking on the checkbox that precedes 

the channel number.

Allow Shared 

SPI

Some transceivers require a dedicated SPI unless additional hardware is provided. If you are using an 

SPI serial EEPROM for external nonvolatile storage, and you want the transceiver and EEPROM to use 

the same SPI peripheral, select this option to allow additional option selection on the PIC® MCU page.

Note 1: Ensure the pin exists on the target device. The application code is responsible for configuring the pin as a 

digital input or output as appropriate.
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3.2.3 Specifying Profile and Endpoint Information

Select the Endpoints tab.

FIGURE 3-3: ZENA™ STACK CONFIGURATION WINDOW, 

ENDPOINTS TAB

Using this window, you can specify the profile and endpoint structure that your 

application is using. See Table 3-3 for configuration options.

CAUTION

It is critical for ZigBee protocol interoperability that this section be accurate.
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TABLE 3-3: ZigBee™ PROTOCOL PROFILE/ENDPOINTS CONFIGURATION SELECTION

Configuration Option Description

Profile Header File Click Browse to browse to and select the header file for the application’s profile. This 

file has profile information in a specific format which the ZENA™ analyzer uses to 

configure many items, including:

- Profile name

- The list of devices supported by the profile

- Allowable input and output clusters

- Range checking for various parameters on other tabs

Device(1) Select the profile device that describes the application.

Endpoints(2) To define an endpoint:

1. Enter the endpoint’s numerical value (1-240) in the “Endpoint” edit box.

2. In the “Endpoint Name” edit box, enter a valid C language label for that end-

point. 

3. Select all of the input and output clusters that are supported by that endpoint 

under “Input Clusters” and “Output Clusters”.

4. Click Save Endpoint to save the endpoint. The endpoint number will be added 

to the “Endpoints” list box.

To define another endpoint:

1. Click New in the “Endpoints” list box. All of the endpoint information will be 

cleared. 

2. Enter the new endpoint’s information and click Save Endpoint.

To view a previously defined endpoint:

Click on the endpoint number in the “Endpoints” list box.

To remove a specified endpoint:

Click the desired endpoint number in the “Endpoints” list box and click Remove 

Endpoint.

Note 1: The ZENA analyzer does not confirm that all mandatory clusters are supported for the selected device.

2: Be sure to click Save Endpoint when you are finished defining an endpoint. If the endpoint information 

has been entered but not saved, the endpoint will not be included in the generated output files.
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FIGURE 3-4: ENDPOINT SPECIFICATION
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3.2.4 Specifying Security Information

Select the Security tab.

FIGURE 3-5: ZENA™ STACK CONFIGURATION WINDOW, SECURITY TAB

This tab is used to configure the security features of the ZigBee protocol Stack. If your 

application will utilize security, select the “Security Capable” option. Security imposes 

the following constraints:

• The Stack requires one additional bank of RAM

• Neighbor table size is limited to 32 (see Table 3-10)

• The APS Address Map must be used (see Max APS Addresses in Table 3-7)

Using this window, you can configure the following items:

TABLE 3-4: ZigBee™ PROTOCOL DEVICE CONFIGURATION SELECTION

Configuration Option Description

Security Capable Select this option if your application will utilize security and send and receive 

encrypted messages.

Security Mode Only “Residential” mode is currently supported by the Stack.

Trust Center Select this option if this device is the trust center.

Trust Center Address If the address of the trust center is known, enter it here.

Network Key Present If the network key is known, enter it here with the “Sequence Number”.

Key present in all devices on 

the network

Select this option if the device is a ZigBee Coordinator or a ZigBee Router and it 

contains the network key and all devices on the network contain the network key.
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3.2.5 Specifying ZDO Layer Information

Click on the ZDO tab.

FIGURE 3-6: ZENA™ STACK CONFIGURATION WINDOW, ZDO TAB

This tab is used to configure the ZDO (ZigBee Device Object) Layer of the Stack. Many 

options on this tab are enabled or disabled based on the “ZigBee Device Type” that is 

selected on the ZigBee Device tab. 

ZigBee allows some network services to be distributed among different devices in the 

network. The Server Capability selection (refer to Table 3-6) is used to describe the 

specific additional services the device capable of providing.
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TABLE 3-5: ZigBee™ PROTOCOL ZDO CONFIGURATION SELECTION

TABLE 3-6: ZIGBEE™ PROTOCOL ZDO SERVER CONFIGURATION SELECTION

Configuration Option Description

Include Optional Service 

Discovery Requests

If selected, the application will support the optional ZDO service discovery requests. 

This feature is not yet supported by the Microchip Stack.

Include Optional Node 

Management Services

If selected, the application will support the optional ZDO node management services. 

This feature is not yet supported by the Microchip Stack.

Support End Device Binding This function is available only on ZigBee protocol coordinators. If selected, enter the 

“End Device Bind Timeout (seconds)” in seconds.

Configuration Option Description

Trust Center This specifies whether the device is capable of serving as a Trust Center.   If yes, 

then indicate whether it is as a primary or a backup Trust Center.    

This feature is not yet fully supported by the Microchip Stack. The ZigBee 

Coordinator is the Trust Center within the Microchip Stack. 

Binding Table Cache This specifies whether the device is capable of serving as a Binding Table Cache i.e. 

a device that can store the Binding Table of other devices. 

This feature is not yet fully supported by the Microchip Stack. Devices can only store 

their own binding tables.

Discovery Cache This specifies whether the device is capable of providing information that describes 

both the identity and services provided by other devices on the network. If yes, then 

indicate whether the device will operate as the primary or backup device, responding 

to discovery requests from other devices.

This feature is not yet fully supported by the Microchip Stack. The Individual Routers 

and Coordinator may respond with service information regarding their own child 

devices, but not for the network as a whole.
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3.2.6 Specifying APS Layer Information

Click on the APS tab.

FIGURE 3-7: ZENA™ STACK CONFIGURATION WINDOW, APS TAB

This tab is used to configure the APS (Application Sub Support) Stack layer.   Some 

options on this tab are enabled or disabled based on the “ZigBee Device Type” selected 

on the ZigBee Device tab.

Many of these options affect the amount of RAM and nonvolatile memory that is used 

by the application. To view the associated memory usage, hover the mouse over the 

appropriate edit box after the box has been enabled.
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